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VAO1l
SAP ORDER
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SALES
SERVICE
LEASE

DISTRIBUTION
CHANNEL : 20
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DIVISION : 60
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DETAILED DESCRIPTION

DIVISION DESCRIPTION ORDER | DESCRIPTION
Lift Irrigation
ZLIS Works
EHT EHT Consumer
Works
30 CUSTOMER | ZEHT EHT Generator
WORKS Works
EHT General
£GNW Works
ZMAT | Sale of Material
SALE OF
40 ZSCP | Sale of Scrap
MATERIAL
ZRET | Return of Material
50 SERVICES | ZSER | Services
LEASE & ZLES | Lease of Material
60
RETURN ZRET | Return of Material
o9 MISCELLANEOUS | ZMIS | Miscellaneous
30/40/ | CREDIT NOTE | ZCRN | Credit / Debit Note
50/60/ with Reference to
99 DEBIT NOTE ZDRN | Invoice for Arrears




SAP DATA CLASSIFICATION
(Divided in to Three Parts)

! |

(a0 = )

MASTER DATA REPORTING DATA
The Details of MASTER DATA \ ( The Details of REPORTING DATA \
Customer Master: XDO1 XDO02 XDO03, VCUST 1. Quotdations: VA25N
Material Master: MMO1 MMO02 MMO3, MM&60, 2. Order: VAO5N
Price Master: VK11 VK12 VK13 V/LD 3. Contracts/Agreements: VA45N
Tax Master: VK11 VK12 VK13 V/LD J \4 Billing/Invoice: VFOSNJ

—

The Details of CUSTOMERS in SAP
. Centrally - Customer: XD01, XD02, XD03

. Sales - Customer: VvDO1, VD02, VD03 4
Finance - Customer: FDO1, FD02, FDO3 TRANSACTION DATA
/ The Details of TRANSACTION DATA \
1. Quotation: VA2]1, VA22, VA23
2. Order: VAOI1, VAO02, VAO03
3. Contract: VAA4]1, VA42, VA43
\4. Billing: VFO1, VF02, VFO03 /




SAP EASY ACCESS

(5 Menu Edit Favorites Extras

& v| «

SAP Easy Access

System  Help

@@ =2lmK 0T

EI'MF G |Voig & | v A

» USER MENU

* [= SAP Menu
v [ Office

b [ oss-Application Components

» SAP MENU_

SAP BUSINESS
» WORK PLACE

* [= Logistics

(E-mail)

v [ Materials Management
* [= Sales and Distribution
v [ Master Data
¥ [T sales Support
* = Sales
v [ Inguiry
* [ Quotation
- ) VA21 - Create
+ ) VA22 - Change
- 2 VA23 - Display
» [ subsequent Functions
* [E Order
« ) VADL - Create
« 2 VAD2 - Change
« 2 VAD3 - Display
» [ customer replenishment
v [ subsequent functions
v [0 scheduling Agreement
* [ Contract
« 2 VA41 - Create
.« 2 VA42 - Change
» ) VA43 - Display
« 1) VACB - Advanced Order Processing and Biling
v [3 subsequent Functions
¢+ [ Backorders
* 3 Product Cost by Sales Order
* [ Environment
v [ Information System
v [ Tools
* [ Shipping and Transportation
* [ Biling
* [ Biling Document
« ) VFO1 - Create
- 1 VFO2 - Change
* ) VFO3 - Display
« ) VFO7 - Display From Archive
- 2 VF11 - Cancel
+ ) VF04 - Process Biling Due List
« ) VFO6 - Background Processing
* ) VFRB - Retro-Biling
- ) VSB1 - Self-Biling Proced.
& @ CMP_PROCESSING - Complaints Processing
» ) VFX3 - Blocked Billing Docs
+ ) VF_VPRS - Update Costs
* [ Country Specifics

SAP MENU

Logistics

Sales & Distribution
Sales

Quotation

VA21 - Create
VA22 - Change/Edit
VA23 - Display/View

Sales

Order

VAOT1 - Create
VAO2 - Change/Edit
VAO3 - Display/View

Sales

Contract

VA41 - Create
VA42 - Change/Edit
VAA43 - Display/View

Sales & Distribution
Billing

Billing Document

VFO1 - Create
VF02 - Change/Edit
VF03 - Display/View

/N = Screen return to
SAP Easy Access

/O => New screen/
Session Create
Opening

Maximum Screens
Allowed is 6 (Six)




SAP ORDER SCREENS

(Divided in to Three Screens)

OVER VIEW

SCREEN
TABS:
Sales
Item Over View
Iltem Details
Ordering Party
Procurement
Shipping
Reason for Reiection

IO oA ORIV S

ITEM OVER VIEW
IMPORTANT:
1. ltem
2. Material ID
3. Description
4. Quantity
5. Unit of Measurement
6. Iltem Category
7. Payment Terms
8. Plant
9. Storage Location
10. Usage

/ ITEM DATA \

@ N AL =

TABS:

. Texts

. Order Data
. Status

. Structure

SCREEN

Sales A

Sales B

Shipping

Billing Document

Bill Plan

Conditions

Account Assignment
Schedule Lines
Partners

Additional Data A
Additional Data B /

EACH LINE ITEM HAVING SCREEN

Using this we can move the Screens

M 4 » M

between Line items

/ HEADER DATA \

go g e D0 Ly =

TABS

. Status
. Additional Data A
. Additional Data B

SCREEN

Sales

Shipping

Billing Document
Accounting
Conditions

Account Assignment
Partners

Texts

Order Data

Order Scheduling /




SAP OVER VIEW PAGE/ FRONT PAGE

X

a
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[ salesdocument Edt Goto Extras  Environment  System  Help > ORDER TOP OVER VIEW TABS
@ -« || « @ '-J:E:"J ﬁ £ @ @ |:_| IEI -+ STANDARD TOOL BAR, SAVE, BACK, EXIT, CANCEIL
— — » DISPLAY DOCUMENT FLOW
|L @%j Overview > ORDER PRINT OUT PUT
O Y | 42 | S0 b TR Nt ek e el >TRANSACTION CODE BOX
Material Sales Ord - Met value 0.00
Sold-To Party —= = »  CUSTOMER ID (1IXXXX XXXXX)
Ship-To Party — » APTRANSCO APPROVAL NO & DATE
CE sl i = » DISPLAY HEADER DETAILS
CUSTOMER HEADERDETAILS R
./ Sales | Ttemoverview  Itemdetal | Ordering party - Procurement - Shipping  Reason for rejection »ORDER OVER VIEW TABS MIDDLE
Icomplete d. Trtal Wainht 0 oonll ] lgELIVERY BLOCK WILL BE ASSIGNED AFTER 15
. | - —— DAYS AND NOT ALLOWED FOR DELIVERY
Delivery block * Volurne 0.000
Biling block |Z1 Pending Approval | Pricing Date 25.08.2017- » PRICING DATE IMPORTANT
Payment card ' ' |Exp.date ' ~ BILLING BLOCK REMOVAL AFTER
Card Verif.Code - APPROVAL OF HEAD OF DEPT
Payment terms o
Incoterms '
Order reason - = »ORDER REASON SELECTED FROM DROP MENU
A€
Al items
Itern | Material Order Quantity Un |5  Description ItCa D|PInt |Amount Croy  Met price per  Metvalue m
S :I Y
if! D -
CUSTOMER LINE ITEM DETAILS ' 117
BREE HED R @
y




OVER VIEW TABS

_/ Sales | Trem overview / temdetal | Ordering party / Procurement | Shipping | 'Reasonforrejection '

Req. defiv.date
["IComplete di.
Delivery block
Biling block
Payment terms
Incoterms
Order reason

Gales area

Al tems

ltem  Material

&=t =3 AN 2 E

s / Removenin | e el

g o g

ol [31.06.2007 Deliver,Plant
Total Waight 0.000
¥ | Yolume 0.000) |

31.08.2017

v

1000/ 120/ / 60 APTRANSCO Sales Ora., Sale, Servic, Lease, APT- Lesi.

Order Quanttty Un 5  Description

b

 Ordering pary  Procurement  Shipping  Reasan for rejection

ItCa 0PIt Amoul

g

Req deivisp D

Al gems

Ttem Materdl - Descrption

Material Description
Unit of Measurement <
Division:10/20/30/40/50/60/99

Item Cateqory: Type of Order <

PAYMENT TERMS: Z001 <
PLANT: SALES OFFICE : PAY UNIT <

STORAGE LOCATION <

OT2007 DelverPant

» ITEM SR No: 10, 20, 30 ETC

> MATERIAL ID:
Service Material: 5000 00XX

SS/Line Material: 1000 XXXX
Scrap NVM Material: 2000 XXXX
Scrap—Material: 4050 XXXX

Order Quanty Un - D. 2 Sas... Pa.. Pt St.. Usage

<

40: ZMAT, ZSCP
60: ZLES, ZRET

USAGE <«

50: ZSER

Het price

NET PRICE <

OVER VIEW TABS

1.
2.

Service Material
SS/Line Material : ZSLM : 1000 XXXX
Scrap Material
Scrap Material

o g kW

10.

11.

12.

13.

ITEM OVER VIEW

Sales

Item Over View
(Deatiled View & No Of items
can be viewed)

Item Details
(Item Deatiled Information)

Ordering Party

Procurement

(This is used for confirmation
of Qty in case of ZMAT,
ZSCP, ZLES)

Shipping

Reason for rejection
(This is used for order short
closing)

INFORMATION

Item

Material ID
: ZSER : 5000 00XX

: ZNVM : 2000 XXXX
: ZSCP : 4050 XXXX

Description

Order Quantity

Unit of Measurement
Division
(10/20/30/40/50/60/99)

Item Category
(Type of order)

Sales District

Payment Terms

(2001)

Plant

(Pay Unit)

Storage Location

(40 : ZMAT, ZSCP, 60: ZLES)

Usage
(50: Services:ZISER)

Net Price




HEADER DATA HEADER DATA TABS

1. Sales
Header Data . .
2. Shipping
B Y% & | @ L
= — _ 3. Billing Document
L.T.T.5. Agreement 2000000108!  Purchase order no. APERC_MYT_2014-201 ..
Sold-to party (8000000000 Andhra Pradesh Northem Power / 2-5-31/2 Corporate Offic.. 4‘ Accounting
. sales | Shipping - Biling Docurment  © Accounting | Conditions | Account zssignment | Partners | Texts | 5. Conditions
Contract Type [zpsa]  LT.T.5. Agreement Document date EOI.US;ZOJ.‘?:" 6. Account ASSignment
Sales area data 1000/ /10| /[10]  APTRANSCO Sales Org., Open Access, APT- Intra State
Sales office [ Created By 'SDCOREZ 7. Partners
Sales group I Created on 101.05.2017
Valid from 01.04.2014| ] Vald to 31.03.2018 8. Texts
Yean ' Feiiin SUBJECT/ Description Of
Order reason | D06 APHPDCL Transmission Service Agreement v| WOI‘k
Check rel. part. | No check -
Master contract References
Defivery time ' M| 9. Order Data
Pricng and Statistis : ] 10. Status
Doc. Currency IR | /| 1.00000 I*i Pricing date lo1.01.2017] L.
Pric. procedure  |ZDSAPP  Pricng Procedu  Customer group * 11. Additional Data A
Price List | ~ | Usage | o o
e - = ST 12. Additional Data B
LINE ITEM DATA TABS
Item Data
1. Sales A
AN T 6 @ R0 Ee
2. Sales B
Sales Document Ttem 10 Tem Category |ZDSA| L.T.S.S. Trarmis lem 3 Shipping
Materl {s0000010 | Transmission Charges - Intra State .
4. Billing Document
/Salesh | Sdest | ‘shonng | ilng Document |/ Blng pan | Condtons | Account assgnment | Partners | Texts 5. Billing Plan
- - 6. Conditions
| Order Quantity and Delvery Date .
| _ —— —_— = —= 7. Account Assignment
Target quantity 3,949.%1 1MGH <> 1|Mev
I
Defvery time \ 8. Partners
- 9. Texts
| General Sales Data )
' —_——————— r— Material Sales Text
Net value 1,082,341,920.00 |INR Euch. Rate | 1.00000
Pricing Date 01.01.2017) 10. Order Data
Wateral entzred 150000010 11. Status
£ L ! 12. Structure
Usage v
aaETe | | 13. Additional Data A
Reason forrejection 27 Biling Pl s completed ¥|Ipraferance 14. Additional Data B

Aftemative to ftem




SUBJECT & REFERENCES AND OTHER INFORMATION IN ORDER

Change EHT General Works 1500552:\ Header Data
Ge | &
EHT General Works 1500552 Purchase order no. GK Test 20180519-1
Sold-to party 100000 SRI DHAMALAKSHMI COTTON & RICE MILLS LTD / A.MUPP .
Accounting Conditions | Account assignment Partners . Texis |' COrder Data
ety ang BE @E B

+ [# subject/ Descriptior
e @F{eﬁarences

EN\‘r SUBJECT/Description of Workl is to be written

Change ENT General Works 1500552 |Header Data]
Fe | &
EHT General Works 1500552 Purchase order no. GK Test 20180519-1
Sold-to party 100000 SRI DHAMALAKSHMI COTTOM & RICE MILLS LTD / A.MUPP ..
Accounting Conditions | Account assignment Partners .- Texts |, Qrder Data i
TXE ty. Lang. (&) EBE
» & Subject/ Description EN i | 1. Lr No: CGM/C,R &P/EPDCL/CO/VSP,/Commerdial/F:DKT/
: References EM D.Mo: 1594/12, Dt: 11.07.2012.

References to he written—"

[ 2. Lr Mo: ED/Plg/SE/S/DE-BL/ADE-2/F:RTSS BVRM/
D.Mo:237/13, Dt: 20.07.2013.
3. Lr Mo: CPT220/SE/PM/RTSS BVRM/D.No: 825/17, Dt:
14.12.2017.
4. U.0 Mo: ED/HRD&Plg/DE-BL/ ADE-2/F:RT55 BVRM /
D.Mo:469/17, Dt: 27.12.2017.
5. Lr Mo: CPT220/SE/PM/RTSS BVRM/D.MNo: 220/18, Dt:
19.01.2018.
6. Lr Mo: CPT220/SE/PM/RTSS BVRM/D.No: 493/18, Dt:
24.07.2018.

7. T.0.0 (CE-Construction}Ms. Mo.727 Di: 29.03.2018.

Change EHT General Works 1500552: Item Data

M 4 » M W B AP [EH &
Sales Document Item 10 Item Category ZSVC' Supervision Charges
Material 50000083 Customer Execution : EHT General Works
~ Conditions Account assignment Schedule lines Partners . Texts " Order Data
TXE ty. Lang. @)% B

. [2 Material Sales Text EN

|

Please enter the following Details:

1. Payment Details, 2. RTGS/DD No, 3. Date, 4. Amount
5. Billing Date, 6. Billing Period: From: DD.MM.YYYY to
DD.MM.YYYY, 7. Any other Information Like any
payments due or already paid and other Imp Info.




CUSTOMER MASTER

When a Customer furnished an Application for Sale, Service & Lease the Concerned
Engineer has to request the Customer to furnish the Information as required for SAP
ERP-APTUNES for further Processing.

The ERP (SAP) Customer Form is available in APTRANSCO Website. Go to the
APTRANSCO web site i.e http://www.aptransco.gov.in/transco/depthome.html and go
to Master Data Forms, click on Customer ID. Know Your Customer Form will be down
Loaded and handed over to customer and request him to furnish the details as early as
possible.

D www.aptransco.gov.in/transco/depthome.html

TLINKS RECENTLY IN NEWS

SAP EMPLOYEE SELF SERVICE(ESS)

HOME T~ABOUTUS ~ACTS&RULES

Electricity Act 2003

RTIACT DOWNLOADS T~ CONTACTUS

LIFE CYCLE MANAGEMENT(FLM)

Electricity Rules 2005
Note : Application Opens in APTRANSCO network, Note : Application Opens in APTRANSCO network.
J(..- " 4 lcapd lsAPd
| |

PROJECT MONITORING SYSTEM
Q N

PROPERTY RETURNS PENSIONER DETAILS

MASTER DATA FORMS

e
B

« Non

The Customer furnished Form should be verified by Both ERP SD Module Core Team
and MDM Core Team. Initially, it is need to check in ERP whether customer already
existed or not. If not, it is required to create new code in ERP. It helps to avoid
inconsistency/duplication of Master data.

IF APPLICANT IS EXISTING CUSTOMER : CUSTOMER MASTER DATA AVAILABLE
TCODE : VCUST WE CAN FIND THE CUSTOMER ID.

Customer List
Qe 2P @ BT BHEE

Customer 'S0rg. DChl |Dv  Name 1 | City MName 1 Street | PostalCode City |Cty Rg |Telephone 1
[100[]000[]27 E'Jlﬂﬂﬂ 20 30  RAVALI SPINMERS PVT LTD TANUKU RAVALI SPINNERS PVT LTD KHANDALLI VILLAGE,PER = 534330  TANUKU IN 01 08819226055
1000000049 1000 20 30  ECOREM EMERGY INDIA PVT L HYDERABAD ECOREN ENERGY INDIA PVT LTD Plot No:481 500033  HYDERABAD IN 36 040 23551394
1000000050 1000 20 30  AXIS WIND FARMS (MPR DAM) HYDERABAD AXIS WIND FARMS (MPR DAM) PVT LTD H.No.6-3-680/8/3 500082  HYDERABAD IN 36 040 23412312/...
1000000051 1000 20 30  AXIS WIND FARMS (TIRUMALA HYDERABAD AXIS WIND FARMS (TIRUMALAYAPALLI) P H.No.6-3-680/8/3 500082  HYDERABAD IN 36 040 23412312[...
1000000052 1000 20 30 AXIS WIND FARMS (PAYALAKU HYDERABAD AXIS WIND FARMS (PAYALAKUNTLA) PVT H.N0.6-3-680/8/3 500082 HYDERABAD N 36 040 23412312/...
1000000053 1000 20 30  AXIS WIND FARMS (VAIRAKAR HYDERABAD AXIS WIND FARMS (VAIRAKARUR) PVT LT H.N0.6-3-680/8/3 500082  HYDERABAD IN 36 040 23412312/...
1000000054 1000 20 30  AXIS EMERGY VENTURES INDI HYDERABAD AXIS ENERGY VEMTURES INDIA PVT LTD H.No.6-3-680/8/3 500082  HYDERABAD IN 36 040 23412312/...
1000000055 1000 20 30  AXIS RENEWABLE ENERGY DE HYDERABAD AXIS RENEWABLE ENERGY DEVELOPMENT  H.No.6-3-680/8/3 500082  HYDERABAD IN 36 040 23412312/...
1000000056 1000 20 30 ANANTASAGAR WIND POWER PV HYDERABAD ANANTASAGAR WIND POWER PVT LTD # 402, 1-2-605 500080  HYDERABAD IN 36 040 27621052
1000000057 1000 20 30  ATRIA WIND POWER PVT LTD BANGALORE ATRIA WIND POWER PVT LTD First Floor No.11 560025  BAMNGALORE IN 10 08049411411
1000000058 1000 20 30  EURUS ENERGY PVT LTD HYDERABAD EURUS ENERGY PVT LTD Plot Mo 44 500097  HYDERABAD IN 01 9000822205
1000000059 1000 20 30 GAMESA WIND TURBINES PVT CHENNAT GAMESA WIND TURBINES PVT LTD Futura, Block B, 600113  CHENNAI M 22 044 30060661
1000000060 1000 20 30  GAMESA REMEWABLE ENERGY P CHENNAI GAMESA RENEWABLE ENERGY PVT LTD Futurz, Block B, 600119  CHENNAI IN 22 044 30060661
1000000061 1000 20 30  HELIOS INFRATECH PVT LTD HYDERABAD HELIOS INFRATECH PVT LTD # 402 500080  HYDERABAD N 36

1000000062 1000 20 30 GUTTASEEMA WIND ENERGY CO HYDERABAD GUTTASEEMA WIND ENERGY COMPANY PVT Plot No:1366 500033  HYDERABAD IN 36 040 23555520
1000000063 1000 20 30 HETERO WIND POWER (PENNAR HYDERABAD HETERD WIND POWER (PENNAR) PVT LTD  7-2-A2,3rd floor,North Eas_ 500018 HYDERABAD IN 36 8897771115
1000000064 1000 20 30  INOX WIND INFRASTRUCTURE VADODARA INOX WIND INFRASTRUCTURE SERVICES L Survey No.1837 8 1834 390007  VADODARA IN 06 0265-6198111/...
1000000065 1000 20 30  JED SOLAR PARKS PVT LTD HYDERABAD JED SOLAR PARKS PVT LTD Plot No:481 500033  HYDERABAD IN 36 040 23551394
1000000066 1000 20 30  POLY SOLAR PARKS PVT LTD CHENMNAI POLY SOLAR PARKS PVT LTD 10th Floor 600018  CHENNAI IN 22 044 42923800
1000000067 1000 20 30  KARAM CHAND THAPAR & BROS  KOLKATA KARAM CHAMND THAPAR & BROS (COAL SAL  Thapar House 700001  KOLKATA IM 25 03340057000
1000000068 1000 20 30  MARUT-SHAKTI ENERGY IMDIA VADODARA MARUT-SHAKTI ENERGY INDIA LTD Survey No.1837 & 1834 390007  VADODARA IN 06 02656198111
1000000069 1000 20 30  MYTRAH ENERGY (INDIA) LTD HYDERABAD MYTRAH ENERGY (INDIA) LTD 8001 500032  HYDERABAD N 36

1000000070 1000 20 30 CUDDAPAH ENERGY PROJECTS VIAYAWADA CUDDAPAH EMERGY PROJECTS PVT LTD 3253 520010  VIAYAWADA IN 01 040 23551374 ...
1000000071 1000 20 30  PEREMNIAL WIND FARM PVT L HYDERABAD PERENNIAL WIND FARM PVT LTD H.No.6-1-1059 500004  HYDERABAD IN 36 040 23230388
1000000072 1000 20 30  SNEHAPRAGATI AGRO TECH PV HYDERABAD SNEHAPRAGATI AGRO TECH PVT LTD Ground Floor 500073  HYDERABAD IN 36 040 23230388
1000000073 1000 20 30 RAYALA WIND POWER CO PVT  HYDERABAD RAYALA WIND POWER CO PVT LTD Plot No:1366 500033  HYDERABAD IN 36 04040301195

1nnnnnnny4 inon 2n an VARSHINT POWFR PROIFCTS T HYDFRARAD MARSHTNT POWFR PROIFCTS THDTA PVT 1 Plot Mno: 44-4/A S00N82 HYDFRARAD ™ 36 n4n 33355552



http://www.aptransco.gov.in/transco/depthome.html

A Transmission Corporation of Andhra Pradesh Limited

’d CUSTOMER ID Creation - Request Form

1) Title : M/s or Mr. or Miss :

2) NAME OF THE CUSTOMER : *

APTIANSCO ( Fields marked with * are Mandatory )

*

AP-TUNES

3) ADDRESS, PHONE & FAX Numbers, E-mail & WEBSITE Information :

ADDRESS *
City *: District * : State * :
Country*: PIN *:

(All phone numbers with STD code)

Phone No * :

Fax No:

4) Ordering ADDRESS :

(if NOT same as above)

5) Contact Person's NAME *

Contact Person's Designation * :

Contact Number * :

E-mail * :

Web URL:

6) REGISTRATION INFORMATION (Furnish the details whichever is applicable) :

PAN *

GSTIN * :

GST Customer Classification:
(Tick q/ whichever applicable)

Registered / Non-Registered / Special Economic Zone(SEZ)

CIN No

7) BANK DETAILS :

*A[C Holder Name :

*Account No:

* JFSC Code:

* Bank Name:

* Branch Name & Address

8) Details of Product/Service
received from APTRANSCO : *

Name & Designation :

Declaration: It iz certified that the information furnished above is true and correct to the best of myv/our knowledge and belief.

Signature of the Customer
with Company Seal




SALES & DISTRIBUTION: GENERAL INFORMATION : USER MANUAL

Document Management System: Document Attachment for Contract/Order: Process

1. Transaction Code :CVOIN
Document type - “F4” > select the ZSD-> Enter.

Go to Document Data Tab  : Write Description. (Short note about document)

> w0 N

Choose Create (Generally 4th button) or open original (Generally 5th button) option listed at
the bottom.

5. Open Create (Generally 4th button), Select the application (Type of File), Description is to be
written, Original and select the file from Computer or open original (Generally 5th button) and
select the file from computer i.e Select the file you want to upload. Now, you will see the
original in your DMS.

6. Right click on the original, select check in and choose storage category. (DMS Content
Server).
7. Go to Object Link Tab-> in these three Items will be there.
i. Customer, Write the Customer ID
i. Material Master, Write the Material ID
ii.  Sales Document, Write the Sales Document Number & Item (Default 10)
Select the appropriate and enter the details and Save.
8. The following information is to be noted.
i. Document
i. DocumentType
ii. Document Part
iv. ~ Document Version

9. Go to Concerned Customer (XD02/03) or Sales Document (VA02/VAO3/VA42/VA43), go to
Exfras Tab, Documents, we can see the attachments.

10. Go to Concerned Material Master (MM02/03), go to additional Data, go to Document Data
Tab, we can see the attachments.

Approval /Work Flow Process through FLM: Contract/Order/Invoice Attachment in FLM
1. Open FLM with User ID & Password

2. Click On Create (Left Side bottom) > Create File > go fo APTRANSCO - Select Type of File
- Note.

Write the details of Priority and Subject and File User Status - Submitted.
Save and Note the File Number which was automatically generated.

Go to Documents - Note Attachment - Object > Document Number (Alpha Numeric
Information without Space) > Document Type (select the appropriate from drop menu:
Sales Document) > Select the Type (Select the appropriate: for SD Module : 1. Open
Access Contract, 2. Sales Invoice & 3. Sales/ Service order) then click on OK. Write the
Number of the 1. Open Access Contract, 2. Sales Invoice & 3. Sales/ Service order then
click on OK.




Add to Noting/Comments and Add to Descriptions anything is required to be written and
click on Post.

Go to Work Flow, add New Work Flow, Add in Sequence and Tick on Approver level, add
processor, Processor (Select Position), sent to Select the appropriate person, and then click
on OK. Similarly way we can add workflow and then click on OK.

Go to Bofttom Right third one and then click on save - click on Send - Send File > OK.
File will be moved to as per work flow.

Concerned person click on sales Document, the file will be open in SAP as per the Roll
Position.

Information Process through SAP Business Work Place (Email): Atachment

1.
2.

Go to SAP Easy Access Menu - 3@ Emblum - SAP Business Work Place

Go to New Message - Title: Subject to Be written - Document Content: Detailed
Information to be written - Recipient: Emp ID or F4 Search for Person - Create
Afttachment: Upload the documents and Send.

Print Outputs Process

Contract/ Order/Quotation Print Output

1.

2.

3.

Transactions Code > VA02/VAO3/VA22/VA23/VA42/VA43 > Write the Sales Document
number 20 or T5XXX XXXXX / 3XXXX XXXXX / SEXXXX XXXXX = go to Sales Document Tab ->
issue Output to = Output Screen Will Open >Select VAOT/VA21/VA41-> Print preview
(Bottom 3@ & 4h) & Order/Contract/ Quotation Document in PDF will be open.

Transactions Code > VA02/VAO3/VA22/VA23/VA42/VA43 > Write the Sales Document
number 20 or T5XXX XXXXX / 3XXXX XXXXX / EXXXX XXXXX = enter & go to Overview Sales
Document > go to Header Output Preview (top 39 Line) and click>
Order/Contract/Quotation Document in PDF will be open.

Transactions Code > VA02/VAO3/VA22/VA23/VA42/VA43 > Write the Sales Document
number 20 or T5XXX XXXXX / 3XXXX XXXXX / EXXXX XXXXX = enter & go to Overview Sales

Document = Extras tab - Output > Header 2 Print Preview—> Order/Contract/Quotation
Document in PDF will be open.

Invoice / Smart Form Print Output Including Return order invoice Print Output

1.

Transactions Code - VFO3 = Write the Invoice/Billing number XXXX XXXXX = go to Biling
Document Tab - issue Output to = Output Screen will Open > Select VFO1-> Print preview
(Bottom 3@ or 4th) > Invoice Document in PDF will be open.

Transactions Code - VFO3 - Write the Invoice/Billing number ?XXXX XXXXX = go to Biling
Document Tab - issue Output to = Output Screen will Open > select ZAPT(Smart
Form)->Print Output = LPO1-> Print preview = PDF! & Invoice Smart Form Document in PDF
will be open.

Outbound Delivery Note / Delivery Return Note or Gate Pass Print Output

1.

Transactions Code = VLO2N/VLO3N > Write the Outbound Delivery Number 4XXXX XXXXX
- go to Outbound Delivery Tab - issue Delivery Output = Output Screen Will Open >
Select ZDEL ->Print preview (Bottom 4th) = Delivery Note will be Open > write PDF! In
Command Filed - Delivery Note in PDF will be open.

Transactions Code = VLO2N/VLO3N > Write the Outbound Delivery Number 4XXXX XXXXX
- go to Outbound Delivery Tab - issue Delivery Output - Output Screen will Open >
select ZDOP(Smart Form)->Print Output > LPO1-> Print preview - PDF! - Invoice Smart Form
Document in PDF will be open.




SALES & DISTRIBUTION: SALES RETURN & CREDIT/DEBIT MEMO/NOTE

SALES RETURN:

Sales Return is the process of returning the purchased goods by the customer because of various

reasons, such as damaged during transportation, inferior quality, overstocking, less or no sales

uptake, or winding up of business by the customer (e.g., in case of trader or dealer). In these
situations, a customer returns the goods purchased. Lease of Equipment or Material (Lease

Process) return also one type of Sale returns.

As per the business agreement between the organization and customer, a credit note is issued in

the name of the customer to settle the accounts.

APTRANSCO having the Process of Return of Material in Two Conditions

1. Sold Material or Equipment Return : ZRET : 1000-20-40 (Sales Area)

2. Lease Material or Equipment Return : ZRET : 1000-20-60 (Sales Area)

APTRANSCO process ZRET (Sale/ Lease return) brings the Material in to APTRANSCO stock. Not

for either Credit Note/Memo or Debit Note/Memo creation.

BILLING/INVOICE:

An invoice is an itemized list of entries for which a Customer has to make payments to its

suppliers, vendors or service providers.

In Case of SD Module APTRANSCO is treated to Supplier, Vendor, or Service Provider to Customer.

The Accounts Receivable Department receives invoices from the respective Sales Wing

(APTRANSCO: Technical Wing) for the Materials supplied or service provided. The Accounts

receivable department matches the items listed on the sale order with that of the invoice.

The Accounts Payable Department receives invoices from the suppliers or vendors and scrutinizes

it before processing it for payment. In most of the cases, company issues Purchase Orders to its

vendors, requesting the items to be supplied to them. The Accounts Payable Department matches
the items listed on the Purchase Order with that of the Invoice and also verifies that the items are
received by them to clear the invoice for the payment.

CREDIT MEMO or CREDIT NOTE:

+ A transaction that reduces Amounts Receivable from a customer is a Credit Memo or Credit

Note. For eg. The customer could return damaged goods.

Credit Memo/Note request is a Sales Document used in complaints processing to request a

Credit Memo/Note for a customer. If the price calculated for the customer is too high, for

example, because the wrong scale prices were used or a discount was forgotten, you can create

a credit memo request.

You can use Credit Memo/Notes in Sales and Distribution (SD) for assigning Credit Memo/Note

requests to the open invoices and in Financial Accounting (FI) for assigning Credit Memo/Notes

and payments to the open invoices and carry out clearing with them. If you use both Financial

Accounting (FI) and Sales and Distribution (SD), there is a 1:1 relationship between the Credit

Memo/Note request and the Credit Memo/Note item posted in Financial Accounting (FI).

When you post Credit Memo/Notes, the payment programme processes them automatically. If

the Credit Memo/Note is specifically related to a particular open invoice item, the payment

program automatically attempts to offset the Credit Memo/Note against the open item.

DEBIT MEMO or DEBIT NOTE:

% A Debit Memo/Note is a transaction that reduces Amounts Payable to a Vendor because; you
send damaged goods back to your vendor. A transaction that Increases the Amounts Receivable
from a customer is a Debit Memo or Debit Note.

+ Debit Memo/Note request is a sales document used in complaints processing to request a Debit
Memo/Note for a customer. If the prices calculated for the customer were too low, for example,
calculated with the wrong scaled prices, you can create a Debit Memo/Note request. It is like a
Standard Order in SAP. The system uses the Debit Memo/Note request to create a Debit
Memo/Note.

+ You can use Debit Memo/Notes in Sales and Distribution (SD) for assigning Debit Memo/Note
requests to the open invoices and in Financial Accounting (FI) for assigning Debit Memo/Notes
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and payments to the open invoices and carry out clearing with them. If you use both Financial
Accounting (FI) and Sales and Distribution (SD), there is a 1:1 relationship between the Debit
Memo/Note request and the Debit Memo/Note item posted in Financial Accounting (FI).
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% When you post Debit Memo/Notes, the payment programme processes them automatically. If
the Debit Memo/Note is specifically related to a particular open invoice item, the payment
program automatically attempts to offset the Debit Memo/Note against the open item.

As mentioned above, creating a Credit or Debit Memo or Note request enables you to create Credit

or Debit Memo or Note based on a complaint.

1. For this first create a Sales Document with the Order type for a Credit or Debit Memo or Note
request. You can create the Credit or Debit Memo or Note requests in the following ways:

« With Reference to an Existing Order (SD Module) (ZRET)
% With Reference to an Existing Contract (SD Module) (ZOCR, ZODR)
» With Reference to an Billing Document / invoice (SD Module) (ZCRN, ZDRN)
« Without Reference to an Order (FI Module)
2. In all cases, you specify the value or quantity that should be in the Credit or Debit Memo or
Note.

ERP SUPPORT SYSTEM:

Go to http://www.aptransco.gov.in/transco/depthome.html and double click on ERP
Support. In this 3 tabs available.

1. End User Login.

2. Support User Login.

3. Support Document.

For SAP Support User they can enter with their login with User Name and Password. Those
who are online that will be displayed.

For SAP End User they can enter with their login with User Nome and Password. They can
Post their queries to concerned module and those who are on line they can afttend and
the queries.

Employees Self Service (ESS) BI/BO Reports:

Go to ESS Portal, go to Bl Reports, SD Revenue Reports you can View. Total revenue
received and Balance to be received and Amount Pending with Customer wise
information is available. We can check.

Avuthorization Issues:

Transaction Code: SU53

Any authorization issues are coming, it is requested to apply T Code : SU53 and send the
screen shot of SU53 to techlead@aptransco.gov.in.

Share Folders Information:

Windows + R : Command Prompt

\\172.27.0.16

A popup window will appear
User Name : apuser
Password: Admin@123

File name share folders

>

.

)

>

A e e




Sales Office: Plant: Shipping Point: Pay Unit

CODE PAY UNIT CODE PAY Unit
5103 SE/OMC/ Visakhapatnam 5114 SE/OMC/ Srikakulam
5109 SE/OMC/ Rajahmundry(Bommuru) 5115 SE/OMC/ Vizianagaram

5116 SE/OMC/ Eluru
5105 SE/OMC/ Vijayawada 5117 SE/OMC/ Guntur
5107 SE/OMC/ Nellore 5118 SE/OMC/ Ongole
5104 SE/O&M/ Kadapa 5119 SE/OMC/ Anathapuram
5110 SE/O&M/ Kurnool 3203 SE/OMC/ Tirupathi
3100 SE/400KV /Const/ Visakhapatham 2601 SE/Telecom/ Vijayawada
3312 SE/400KV / OMC/ Vijayawada 2602 SE/Telecom/ Kadapa
3315 SE/400KV / OMC/ Kadapa 2605 SE/Telecom/ Visakhapatnam
Stores Also Plant: Under control of Concerned SE (Plant)

CODE Stores Plant (Control Unit) CODE Stores Plant (Control Unit)
1010 Gajuwaka Stores (5103) 1030 Bommuru Stores (5109)
1040 Gunadala Stores (5105) 1050 Ongole Stores (5118)
1060 Kurnool Stores (5110) 1070 Kadapa Stores (5104)
1020 Kadiyam 400KV Stores (3100)

General Ledger (G/L) Accounts or Chart of Accounts:

General Ledger (G/L) Account errors are coming during the process. For Understanding GL Accounts the
details are enclosed here with. These are to be verified at the time of Contract/Order Creation. This is

configured based on the Header Level & Item Level.

HEADER ITEM : ACCOUNTING TAB

| LINE ITEM : BILLING DOCUMENT TAB

ACCOUNTING (SUB HEADING) : ACCOUNT ASSIGNMENT GROUP

CODE CUSTOMER A/c Assign Group CODE MATERIAL A/C Assignh Group
01 APEPDCL 01 Transmission Charges
02 APSPDCL 02 SLDC Operating Charges
03 APCPDCL 03 SLDC Annual Fee
04 APNPDCL 04 Lift Irrigation Works
05 Long Term Open Access (LTOA) 05 EHT Customer Works
06 OAG - APEPDCL 06 EHT General Works
07 OAG - APSPDCL (Old) 07 Sale of Material
08 OAG - ATP & KNL 08 Services
09 TSSPDCL 09 Lease & Return
10 TSNPDCL 10 Miscellaneous
11 POSOCO - SRLDC 11 Development Charges
12 POSOCO - WRLDC 12 Wheeling Fee - APEPDCL
13 POSOCO - ERLDC 13 Wheeling Fee - APSPDCL
14 POSOCO - NRLDC
15 POSOCO - NERLDC
16 IEX
17 PXI
18 SALE, SERVICE, LEASE (SSL)
19 Medium Term OA (MTOA)
20 Short Term Open Access (STOA)
21 Short Term PP (STPP)




HEADER ITEM: ACCOUNTING TAB: ACCOUNTING (SUB HEADING): ACCOUNT ASSIGNMENT GROUP

Sales |, Shipping |, Biling Docurment / Accounting ], Conditions |, Account assignment

Accounting |

AcctAssgGr *| Payment Method B
o | ' Exch.rate-acct. ' |

' CCodeToBeBiled 3000 APTRANSCO

Posting Period

Assignment

Dunning Key

Dunning Block | Freed for dunning v |
[ |

Reference

LINE ITEM: BILLING DOCUMENT TAB: ACCOUNTING (SUB HEADING): ACCOUNT ASSIGNMENT GROUP

SalesA | SalesB - Shipping ocument -;H"E.thg phn - Conditions " Account 3

Payer | |
| Delivery and Payment Terms
Incoterms CER| '[:n.st. and ﬁieght
Fixed val.date ' |
Payment Terms [ Add.value days i
| Biling | Accounting
Biling block 1Z1 EliIIIing Approval *| | Acct asgnmt grp |_ ¥
Invoicing dates | v Payment Method B
Biling Date | | Posting Period EUPH_|
Serv.rendered | | Exch.rate-acct. |
Tax classific, allo] Dunning Key | v|
SubsInvProcess | | Dunning Block ' Freed for dunning v
Rev. recog [ Revenue Dist. [
Acc, start [] Revenue Event !—l

' Risk Management




TRANSACTION CODES:

CODE PURPOSE CODE PURPOSE
VCUST List of Customers VA45N List of Contracts
XDO03 Display of Customer VF04 Maintain Bill Due List
MM60 List of Material VFO5N List of Billing Documents
MMO03 Display of Material VF11 Cancellation of Biling Document
MMBE Stock Over View- Single Item VFX3 List of Blocked Billing Documents
MB52 Display Warehouse Stock VA25N List of Quotations
MB58 Consignment at Customer VAO5N List of Orders
MB51 Material Doc No VAO6 Sale Order Monitor
V/LD Price Master Information SDV1 Expiring Contracts
VK13 Display Price Master Condition SDV2 Expired Contracts
CVO04N Find Document: Selection Criteria SDV3 Completed Confracts
VLOIN OBD & PGl or IBR & PGR Creation SDD1 Duplicate Sales Documents
VLO2N OBD & PGl or IBR & PGR Change VLO3N OBD & PGl or IBR & PGR Display
VL06O OBD & IBR Monitor
FBLIN Vendor Line Item Display FBL5N Customer Line Item Display
ZSD_BL0O01 | Open Access Invoiced Related Arrears Reports
ZSD_BL0O03 | Transmission Charges Statistical & Wheeling Charges Report
ZSD_S0O007 | Open Access Biling Block Removal & Billing/Invoicing
ZSD_SO010 | Open Access Biling Block Removal & Capacity Confirmation
ZSD_SO011 | Open Access Billing/Invoicing
ZSD BLO04 | Biling Generated Report & Release to Accounting
ZSDBILLDUE | Biling/Invoice Documents Not Posted to Accounting

ZSCRAP_CREATE ‘ Scrap (BAPI) Excel sheet Upload format for Creation Scrap Sale order

Storage Location:

15t Letter Represents Zone
V - Visakhapatnam Zone

B - Vijayawada Zone <

X

X X X

K - Kadapa Zone
2nd | etter Represents

0 &1 2 132 KV Substation)
2 - 220 KV Substation
3 - Lines and Other Sy
4 > 400 KV Substations> <
5 - Division Offices

6 - Circle Offices
999 - Zonal Offices J

J

Sr Number

bdivisions (Except Maintanence Subdividions)




NUMBER RANGES:

1. Material Master Number Ranges

Range Purpose Range Purpose
1000 0000 to ISLM : Substation & Line 2000 0000 to ZNVM : Non Valuated
1999 9999 Material 2009 9999 Material
3000 0000 to Future /S 4000 0000 to ZSUP : IFS Scrap Material
3999 9999 viure /spare 4049 9999 (Valuated)
4050 0000 to LSCR : Scrap Material 5000 0000 to 7SER: Service Material
4999 9999 (Non Valuated) 5000 9999 '
6000 0000 to 7TPR - Tower Parts 7000 0000 to ITPC: T&P and
6999 9999 ’ 7999 9999 Consumables
8000 0000 to ITOW : Towers & SS 9000 0000 to )
8000 9999 Structures 9999 9999 ZNST: Non Stock ftems
2. SD Module Number Range (SNRO/SNUM : RV_BELEG)
Range Purpose Range Purpose
10000 00000 to . 15000 00000 to VAA41 : Open Access
19999 99999 | XPO1: Customer Master 19999 99999 | Confracts
20000 00000 to Inbound Delivery (MM 30000 00000 to .
29999 99999 | Module] 39999 99999 | VAOT - SSL Order
40000 00000 to VLO1TN (601/602): Delivery : | 49000 00000 to VI\I/-\(I)VZ\TA“(S]I/ 62% PC(;]: & PCR
49999 99999 | OBD & IBR (Ret Del) 49999 99999 | | oaule ~15000s
Movement-MBS51)
50000 00000 to . . 60000 00000 to .
59999 99999 VA21: Quotation £9999 99999 STO Delivery (MM Module)
70000 00000 to VFO1: Statistical Invoices 80000 00000 to One Time Customer Pay
79999 99999 ‘ 80000 00025 Unit Wise
85000 00000 to VF11 : Cancellation of 90000 00000 to VFO1: Financial Invoices
85999 99999 Invoices 99999 99999 '

3. Official Document Number (ODN) for GST Purpose

Purpose CODE Year Number Range Purpose
80000 00000 to . . .
Customer . 2018 88999 99999 SSL: VAO1 : Sales, Service, Lease
Invoices (2018-19) | 90000 00000 to . .
98999 99999 OA : VA41 : Open Access
89000 00000 to . . .
Cusl,;zrl?i;ar . 2018 89499 99999 ZDRN : VAO1 : Sales, Service, Lease
. (2018-19) | 99000 00000 to . .
Invoices 99499 99999 ZOCR : VA41 : Open Access
Customer 89500 00000 to ZCRN : VAO1 : Sales, Service, Lease
Credit cc 2018 89999 99999
X (2018-19) | 99500 00000 to . .
Invoices 99999 99999 ZODR : VA41 : Open Access




GOODS AND SERVICE TAX INFORMATION

Permanent Account Number (PAN
Format of GSTIN

AAAAAOO000A 1 Z 5
22 AAAAAOODDA 125 s
Entity number of the same
T 1| _r) Lr Lr PAN holder in a state
St Code Benmument Accoul Number (PAN) Enty sumber of Alphabet Check sum Alphabet ‘Z’ by default
thesamePAN 2Dy i
holder m a state default
Check sum digit
Sr. Name of the Service MATERIAL GST SAC GST APPLICABLE %
No ID Chapter CODE | SGST | CGST | IGST
INTRASTATE OPEN ACCESS : 1000-10-10
1 | Intra State : Transmission Charges 5000 0010 9969 996911 0 0 0
2 | Infra State : SLDC Operating Charges 5000 0011 9969 996911 0 0 0
3 | Infra State : SLDC Annual Fee 5000 0012 9969 996911 0 0 0
4 | Intra State : Transmission Charges : MWD 5000 0013 9969 996911 0 0 0
5 | Intra State : SLDC Annual Fee : MWD 5000 0014 9969 996911 0 0 0
6 | Intra State : Transmission Charges :MWH 5000 0015 9969 996911 0 0 0
7 | Intra State : Transmission Charge : EXIT 5000 0016 9969 996911 0 0 0
8 | Intra State : SLDC Op. Charges : EXIT 5000 0017 9969 996911 0 0 0
9 | Intra State : SLDC Annual Fee : EXIT 5000 0018 9969 996911 0 0 0
10 | Intra State : Transmission Charges:STAT 5000 0019 9969 996911 0 0 0
INTERSTATE OPEN ACCESS : 1000-10-20
1 | Inter State : Transmission Charges 5000 0020 9969 996911 0 0 0
2 | Inter State : SLDC Operating Charges 5000 0021 9969 996911 0 0 0
3 | Inter State : SLDC Annual Fee 5000 0022 9969 996911 0 0 0
4 | Inter State : Transmission Charges (B&C) 5000 0023 9969 996911 0 0 0
5 | Inter State : SLDC Charges (B&C) 5000 0024 9969 996911 0 0 0
6 | Inter State : Transmission Charge : EXIT 5000 0025 9969 996911 0 0 0
7 | Inter State : SLDC Op. Charges : EXIT 5000 0026 9969 996911 0 0 0
8 | Inter State : SLDC Annual Fee : EXIT 5000 0027 9969 996911 0 0 0
9 | Inter State : Transmission Charges-STAT 5000 0028 9969 996911 0 0 0
10 | Inter State : Wheeling Charges : APEPDCL 5000 0029 9969 996912 0 0 0
11 | Inter State : Wheeling Charges : APSPDCL 5000 0030 9969 996912 0 0 0
1 Enhancement of CMD : Development Charges 5000 0050 9969 996911 0 0 0
2 | Customer Execution_Lift Irrigation Works 5000 0051 9983 998393 9% 9% 18%
3 Customer Execution : Consumer (BL) Works | 5000 0052 9983 998393 9% 9% 18%
Customer Execution : Consumer (BL:SEZ) Works 5000 0052 9983 998393 NA NA 18%
4 | Customer Execution_Generator (GC) Works 5000 0053 9983 998393 9% 9% 18%
5 | Customer Execution : EHT General Works 5000 0054 9983 998393 9% 9% 18%
6 | Customer Execution : Development Charges | 5000 0055 9969 996911 0 0 0
7 | APTRANSCO Execution_Lift Irrigation Work 5000 0056 9954 995422 6% 6% 12%
8 | APTRANSCO Execution_Consumer (BL) Works | 5000 0057 9954 995423 9% 9% 18%
9 | APTRANSCO Execution_Generator (GC) Works 5000 0058 9954 995423 9% 9% 18%
10 | APTRANSCO Execution_EHT General Works | 5000 0059 9954 995423 9% 9% 18%
11 | APTRANSCO Execution_Development Charges 5000 0060 9969 996911 0 0 0
APTRANSCO Execution_RTSS : Railway Works
12 Ex: Railways. 4 5000 0061 9954 995421 6% 6% 12%
APTRANSCO Execution_GenWorks Sp Customer
13 Ex: Railways & NHAI - P 5000 0062 9954 995421 6% 6% 12%
14 | APTRANSCO_CUST Execution : Bay Land Cost 5000 0063 9986 998611 0% 0% 0%




SALE OF MATERIAL & SCRAP : 1000-20-40

Material Description will be maintained at MM Module.

1.
2. Material ID will be maintained at MM Module.
3. GST Chapter & Material HSN Codes will be maintained at MM Module & SD Module
4. Tax Master Maintenance under the Scope of FICO & SD Team.
REVENUE ON SERVICES : 1000-20-50
1 | O&M Services —SS, SWS, Bays & Lines 5000 0071 9987 998719 2% 9% 18%
2 | Revenue on O&M Services — Telecom 5000 0072 9987 998716 2% 9% 18%
3 | Revenue on Hot Line Services 5000 0073 9987 998719 9% 9% 18%
4 | Revenue on Testing Services 5000 0074 9983 998346 9% 9% 18%
5 | Revenue on Consultancy Services 5000 0075 9983 998393 2% 9% 18%
6 | Revenue on General Services 5000 0076 9997 999799 9% 9% 18%
Accommodation Services
7 Ex: Guest House & Hostel 5000 0077 9963 996311 9% 9% 18%
8 | Revenue on Training Services 5000 0078 9992 999294 9% 9% 18%
9 | Line Shutdown Compensation Charges 5000 0079 9986 998631 9% 9% 18%
LEASE & RETURN OF MATERIAL : 1000-20-60
Lease/Rent of Land
1 Ex: SS Vacant Land lease 5000 0081 9972 997212 9% 9% 18%
Lease/Rent of Commercial Building
2 | Ex: Bank, ATM, Post Office, Shop & Diary 5000 0082 9972 997212 9% 9% 18%
Parlour
3 Le.ose/Ren’r of Residential Building 5000 0083 9979 997911 9% 9% 18%
Ex: Quarters
4 | Lease/Rent of Transport Vehicle 50000084 | 9973 | 997311 | 9% | 9% | 18%
Ex: Lorry & Crane
5 | Lease/Rent of Non Stock tem 50000085 | 9973 997319 | 9% | 9% | 18%
Ex: Testing Instruments
6 | Lease/Rent Of EHT EqQuipment 5000 0086 9973 997319 9% 9% 18%
REVENUE ON MISCELLANEOUS : 1000-20-99
] | Revenue on Miscellaneous | 5000 0099 | 9997 | 999799 | 9% | 9% | 18%

SEZ Customers as per GST law Only IGST is applicable. Hence, Tax Classification of Customer shall maintain 2
(SEZ Customers) in place of either 0 or 1. VK11 shall maintain, With in Region (0) & Tax Classification-SEZ (2),
IGST to be Maintained.

Customer State GSTIN State Customer Tax Classification | Applicable GST
01: AP 37 : AP SGST: 0, CGST: 0, IGST: O | GST exemption
01: AP 37 : AP SGST: 1, CGST: 1, IGST: 1 | SGST & CGST
State # 01 (out of AP) | State # 37 (out of AP) | SGST: 1, CGST: 1, IGST: 1 IGST
01: AP : SEZ 37:AP SGST: 2, CGST: 2, IGST: 2 IGST




ORDER REASONS

Whenever service agreements or sale order creating, the order reasons shall be

filtered. Document wise and Division wise.

Doc. Type | Division | Code | Description

OPEN ACCESS

10 - Intra State | 20- Inter State

DISCOM Long Term Transmission Service Agreements

ZDSA 10 D01 | APEPDCL Transmission Service Agreement
ZDSA 10 D02 | APSPDCL Transmission Service Agreement
ZDSA 20 D03 | TSSPDCL Transmission Service Agreement
ZDSA 20 D04 | TSNPDCL Transmission Service Agreement
ZDSA 10 DOS | APCPDCL Transmission Service Agreement
ZDSA 10 D06 | APNPDCL Transmission Service Agreement

Intra State Open Access Generators - Service Agreements APSEB Regime

ZOAG 10 001 | OA —Intra - A.P.S.E.B Agreement - APEPDCL
ZOAG 10 002 | OA — Intra - A.P.S.E.B Agreement — Old SPDCL
ZOAG 10 003 | OA - Intra - A.P.S.E.B Agreement — KNL & ATP

Intra State Open Access Service Agreements

ZLOA 10 004 | OA - Intra - Long Term Open Access Agreement
ZMOA 10 005 | OA - Intra - Medium Term Open Access Agreement
ZSOA 10 006 | OA - Intra - Short Term Open Access Agreement
ZSOA 10 007 | OA - Intra — Short Term Power Purchases

Inter State Open Access Service Agreements

ZLOA 20 008 | OA — Inter - Long Term Open Access Agreement

ZMOA 20 009 | OA - Inter - Medium Term Open Access Agreement
ZSBC 20 010 | OA - Inter - Short Term Bilateral(POSOCQO) Open Access
ZSBC 20 011 | OA - Inter - Short Term Collective (IEX) Open Access
ZSBC 20 012 | OA - Inter - Short Term Collective (PXI) Open Access

Inter State Open Access Service Agreements

ZP0OC | 20 | 013 —[ Po.C : Inter State Po.C Charge Agreement
Open Access Credit and Debit Arrears
ZODR 10, 20 ODA | O.A : Debit Arrears : Capacity Increase
ZODR 10, 20 ODR | O.A : Debit Arrears : Price Increase
ZODR 20 PDR | Po.C. Charges — Debit Arrears
ZOCR 10, 20 OCA | O.A: Credit Arrears : Capacity Decrease
ZOCR 10, 20 OCR | O.A : Credit Arrears : Price Decrease
ZOCR 20 PCR | Po.C. Charges — Credit Arrears
EHT CUSTOMER WORKS (1000-20-30)
ZLIS 30 LIS Lift Irrigation Scheme Works
ZEHT 30 EO1 EHT Consumer - New Works
ZEHT 30 EO02 | EHT Consumer — Enhancement of CMD
ZEHT 30 EO3 | EHT Consumer - Start Up Power of EHT Generators
ZEHT 30 EO4 | Railway Traction SS Works
ZEHT 30 GO1 | Generators - Conventional - Thermal
ZEHT 30 GO02 | Generators - Conventional - Gas
ZEHT 30 GO03 | Generators - Conventional - Hydel
ZEHT 30 G04 | Generators - Non Conventional - Wind
ZEHT 30 GO5 | Generators - Non Conventional - Solar
ZEHT 30 G06 | Generators - Non Conventional - Mini Hydel
ZEHT 30 GO07 | Generators - Non Conventional - Rice Husk
ZEHT 30 GO08 | Generators - Non Conventional - Municipal Solid Waste
ZEHT 30 G09 | Generators - Co-Located Captive (Conventional) Thermal
ZEHT 30 G10 | Generators - Co-Located Captive (Non-Conventional) Solar
ZEHT 30 G11 | Generators - Co-Located Captive (Non-Conventional) Bagasse
ZEHT 30 G12 | Generators - Co-Located Captive (Non-Conventional) BLDS
ZEHT 30 G13 | Generators - Co-Located Captive (Non-Conventional) Co-Generation
ZEHT 30 G14 Generators - Co-Located Captive (Non-Conventional) Waste Heat Recovery
ZEHT 30 G15 | Generators- Not covered- Others
ZGNW 30 GW1 | General Substation Works
ZGNW 30 GW2 | General Switching Station Works
ZGNW 30 GW3 | General Bay Extension Works
ZGNW 30 GW4 | General Lines




ZGNW 30 GWS5 | General Substation & Associated Lines
ZGNW 30 GW6 | General Switching Station & Associated Lines
ZGNW 30 GW?7 | General Bay Extension & Associated Lines
ZGNW 30 GWS8 | Re-Orientation / Diversion of Lines
ZGNW 30 GW9 | Public Interested Government Works
ZGNW 30 G16 | Metering CT & PT Providing or Replacement
SALE OF MATERIAL & SCRAP (1000-20-40)
ZMAT 40 MO1 Sale Of Used Transformer Oil
ZMAT 40 MO2 | Sale Of Equipment
ZMAT 40 MO3 | Sale Of Raw Material
ZSCP 40 MO04 | Sale Of Scrap
ZSCP 40 MO1 Sale Of Used Transformer Oil
RETURN OF MATERIAL (1000-20-40)
ZRET 40 RO1 | Return of Sold Equipment
ZRET 40 RO2 Return of Sold Raw Material
ZRET 40 RO4 Sale Return
REVENUE ON SERVICES (1000-20-50)
ZSER 50 S01 O & M- Substations
ZSER S0 S02 | O & M- Switching Stations
ZSER 50 S03 | O & M- Bays
ZSER S0 S04 O & M- Lines
ZSER 50 S05 | O & M- Telecom Equipment
ZSER 50 S06 | Hotline Services
ZSER 50 S07 | Testing Services
ZSER 50 S08 | Consultancy Services
ZSER 50 S09 | General Services
ZSER S0 S10 | Accommodation Services
ZSER 50 S11 | Training Services
ZSER 50 S12 | O & M- Bays & Lines
ZSER 50 S13 | Line Shut Down - Compensation Charges
REVENUE ON LEASE (1000-20-60)
ZLES 60 LO1 Lease Of Land
ZLES 60 L02 | Lease Of Commercial Building
ZLES 60 LO7 | Lease of Residential Building
ZLES 60 LO3 Lease Of T & P
ZLES 60 L04 | Lease Of Equipment
ZLES 60 LO6 | Lease of Transport Vehicles
ZLES 60 LOS | General Lease / Rentals
ZLES 60 LO8 Lease of Non Stock Item
RETURN OF LEASE EQUIPMENT (1000-20-60)
ZRET 60 | RO3 | Return of Leased Equipment
Revenue on Miscellaneous (1000-20-99)
ZMIS 99 | MIS | Miscellaneous
Sales Service Lease Credit and Debit Arrears
ZCRN 30 CLI APT Execution_LIS_Credit Arrears Note
ZDRN 30 DLI APT Execution_LIS Debit Arrears Note
ZCRN 30 CR4 | APT Execution_NonLIS_Credit Arrears Note
ZDRN 30 DR4 | APT Execution_NonLIS Debit Arrears Note
ZDRN 30 DR6 | APT Exe : Debit Arrears : DVC Increase
ZCRN 30 CR6 | APT Exe : Credit Arrears : DVC Decrease
ZCRN 30 CR5 CUSTOMER Execution_Credit Arrears Note
ZDRN 30 DR5 CUSTOMER Execution_Debit Arrears Note
ZDRN 30 DRM | Cust Exe : Debit Arrears : DVC Increase
ZCRN 30 CRM | Cust Exe : Credit Arrears : DVC Decrease
ZDRN 40,50,60,99 | DRN | SSL Order : Debit Arrears Note
ZCRN 40,50,60,99 | CRN | SSL Order : Credit Arrears Note
ZDRN 40,50,60,99 | DR1 | Finalization of Provisional assessment
ZCRN 40, 50, 60,99 | CR1 | Deficiency in services
ZDRN 40,50,60,99 | DR2 | Correction in Invoice
ZCRN 40,50,60,99 | CR2 | Correction in Invoice
ZDRN 40,50,60,99 | DR3 | Others
ZCRN 40,50,60,99 | CR3 | Others




USAGE INDICATORS

Whenever Contracts/Open Access or Service agreements or sale order creating,
the Usage shall be filtered. Document wise and Division wise.

Sales Doc. Division Usage Description Af\G : Account DESCRIPTION

Type Assignment Group

ZSBC 20 01 11 KV APEPDCL 16 IEX

ZSBC 20 01 11 KV APEPDCL 17 PXI

ZSBC 20 02 33 KV APEPDCL 16 IEX

ZSBC 20 02 33 KV APEPDCL 17 PXI

ZSBC 20 03 11 KV APSPDCL 16 IEX

ZSBC 20 03 11 KV APSPDCL 17 PXI

ZSBC 20 04 33 KV APSPDCL 16 IEX

ZSBC 20 04 33 KV APSPDCL 17 PXI

ZSBC 20 05 11 KV APCPDCL 16 IEX

ZSBC 20 05 11 KV APCPDCL 17 PXI

ZSBC 20 06 33 KV APCPDCL 16 IEX

ZSBC 20 06 33 KV APCPDCL 17 PXI

ZSBC 20 07 11 KV APNPDCL 16 IEX

ZSBC 20 07 11 KV APNPDCL 17 PXI

ZSBC 20 08 33 KV APNPDCL 16 IEX

ZSBC 20 08 33 KV APNPDCL 17 PXI

ZSER S0 09 132KV SS 18 Sale, Service, Lease
ZSER S0 10 220KV SS 18 Sale, Service, Lease
ZSER 50 11 400KV SS 18 Sale, Service, Lease
ZSER S0 12 132KV SWS 18 Sale, Service, Lease
ZSER S0 13 220KV SWS 18 Sale, Service, Lease
ZSER 50 14 400KV SWS 18 Sale, Service, Lease
ZSER 50 15 33KV Bay 18 Sale, Service, Lease
ZSER S0 16 132KV Bay 18 Sale, Service, Lease
ZSER S0 17 220KV Bay 18 Sale, Service, Lease
ZSER 50 18 400KV Bay 18 Sale, Service, Lease
ZSER S0 19 132KV Line 18 Sale, Service, Lease
ZSER 50 20 220KV Line 18 Sale, Service, Lease
ZSER 50 21 400KV Line 18 Sale, Service, Lease
ZSER 50 22 Telecom 18 Sale, Service, Lease
ZSER 50 23 Hot Lines 18 Sale, Service, Lease
ZSER 50 24 Testing 18 Sale, Service, Lease
ZSER 50 25 Consultancy 18 Sale, Service, Lease
ZSER 50 26 General 18 Sale, Service, Lease
ZSER 50 27 Accommodation 18 Sale, Service, Lease
ZSER 50 28 Training 18 Sale, Service, Lease
ZSER 50 29 33KV Bays & Lines 18 Sale, Service, Lease




PAYMENT TERMS

OPEN ACCESS (1000-10-10)

OPEN ACCESS (1000-10-20)

Sales Division Item Payment Sales Division Item Payment
Type Category Terms Type Category Terms
ZDSA 10 ZDSA ZT30 ZDSA 20 ZDSA ZT30
ZDSA 10 ZDSB ZS30 ZDSA 20 ZDSB ZS30
ZDSA 10 ZDSC ZA10 ZDSA 20 ZDSC ZA10
ZDSA 10 ZTRS ZT30 ZDSA 20 ZTRS ZT30
ZLOA 10 ZLOA ZT15 ZLOA 20 ZLOA ZT15
ZLOA 10 ZLOB ZS15 ZLOA 20 ZLOB ZS15
ZLOA 10 ZLOC ZA10 ZLOA 20 ZLOC ZA10
ZLOA 10 ZLOD ZTO01 ZLOA 20 ZLOD ZT01
ZLOA 10 ZLOE 2501 ZLOA 20 ZLOE ZS01
ZLOA 10 ZLOF ZA01 ZLOA 20 ZLOF ZA01
ZLOA 10 ZTRS ZT15 ZLOA 20 ZTRS ZT15
ZMOA 10 ZMOA ZT15 ZMOA 20 ZMOA ZT15
ZMOA 10 ZMOB ZS15 ZMOA 20 ZMOB ZS15
ZMOA 10 ZMOC ZA10 ZMOA 20 ZMOC ZA10
ZMOA 10 ZMOD ZTO01 ZMOA 20 ZMOD ZT01
ZMOA 10 ZMOE 2501 ZMOA 20 ZMOE ZS01
ZMOA 10 ZMOF ZAO01 ZMOA 20 ZMOF ZA01
ZMOA 10 ZTRS ZT15 ZMOA 20 ZTRS ZT15
ZSOA 10 ZSOA ZT15 ZSBC 20 ZSBC ZT01
ZSOA 10 ZSOB ZS15 ZSBC 20 ZSBD ZS01
ZSOA 10 ZS0C ZA10 ZSBC 20 ZWHL ZW01
ZSOA 10 ZSOD ZT01 ZOCR 20 ZOCR ZT01
ZSOA 10 ZSOE ZS01 ZOCR 20 ZOCR ZT15
ZSOA 10 ZSOF ZAO01 ZOCR 20 ZOCR ZT30
ZSOA 10 ZSTP ZT15 ZOCR 20 ZOCS ZS01
ZSOA 10 ZSTR ZA10 ZOCR 20 ZOCS ZS15
ZSOA 10 ZTRS ZT15 ZOCR 20 ZOCS ZS30
ZOAG 10 ZOAG ZT15 ZOCR 20 ZOCT ZA10
ZOAG 10 ZOAH ZS15 ZODR 20 ZODR ZT01
ZOAG 10 ZOAI ZA10 ZODR 20 ZODR ZT15
ZOAG 10 ZTRS ZT15 ZODR 20 ZODR ZT30
ZOCR 10 ZOCR ZTO01 ZODR 20 ZODS ZS01
ZOCR 10 ZOCR ZT15 ZODR 20 ZODS ZS15
ZOCR 10 ZOCR ZT30 ZODR 20 ZODS ZS30
ZOCR 10 ZOCS ZS01 ZODR 20 ZODT ZA10
ZOCR 10 ZOCS ZS15 SALES, SERVICE LEASE (1000-20-30/40)
ZOCR 10 ZOCS ZS30 ZQOT 30 ZQOT 7001
ZOCR 10 ZOCT ZA10 ZQOT 30 ZQOT ZD01
ZODR 10 ZODR ZTO01 ZLIS 30 ZLIS Z001
ZODR 10 ZODR ZT15 ZLIS 30 ZLIS ZD01
ZODR 10 ZODR ZT30 ZLIS 30 ZSVC 7001
ZODR 10 Z0ODS ZS01 ZLIS 30 ZSVC ZDO01
ZODR 10 Z0ODS ZS15 ZEHT 30 ZEHT Z001
ZODR 10 ZODS ZS30 ZEHT 30 ZEHT ZDO01
ZODR 10 ZODT ZA10 ZEHT 30 ZSVC Z001

SALES, SERVICE, LEASE (1000-20-50/60/99) ZEHT 30 ZSVC ZDO01
ZSER 50 ZSER Z001 ZGNW 30 ZGNW Z001
ZSET 50 ZSET Z001 ZGNW 30 ZSVC Z001
ZLES 60 ZLES Z001 ZMAT 40 ZMAT Z001
ZLES 60 ZLET Z001 ZSCP 40 ZSCP Z001
ZRET 60 ZRET Z001 ZRET 40 ZRET Z001
ZMIS 99 ZMIS Z001




CUSTOMER KYC GUIDELINES

Presently Customer KYC/ID is collecting from the customer after receipt of
amount from the customer. This is causing delay in creation of Order & Invoice in
SAP. As per GST Law, the amount received in a month has to furnish the GST
return by 10th of Next Month. Failing which, it attracts penalty @2% on GST
Amount and Audit issue will arises. Hence, it is requested to send the Customer
KYC form along with intimation of estimate without delay.

It is requested to send furnish the soft copy of estimate to
sdone@aptransco.gov.in & sdsapaptunes@gmail.com without fail.

The Customer KYC form is available in APTRANSCO web site.
http://www.aptransco.gov.in/transco/depthome.html --> Master Data Forms -->
double click on Customer ID. The excel sheet will download.

After receipt of KYC form, it is requested to verify the GST details of Customer in
GST Portal.

https://www.gst.gov.in/ --> Search Tax Payer --> Search by GSTIN/UIN -->
enter the GSTIN/UIN of Tax Payer. The details will be available.

B Goods And Services Tax Metwoflk [IM] https.//services.gst.gov.in/services/searchtp

Goods and Services Tax

Services - GST Law Downloads -

Home - Search Taxpayer - Search by GSTIN/UIN

Search Taxpayer

GSTIMN/UIN of the Taxpayer®

Further, it is requested to specify the GST exempted Customer or SEZ
Customer. The GST Applicable for SEZ Customer is IGST only. The Details are
as follows for information.

The GST code details as follows
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2
"

State Code

Format of GSTIN

AMAAOO00A 175

the sume PAN 7" by
holder m astate default

Permunent Account Number (PAN)

Permanent Account Number (PAN)

22 AAAAAO0000A 1

State Code

\hg]l

The APSPDCL GST Information as follows:

Search Result based on GSTIN/UIN : 37AAHCS4056Q22ZM

GSTIN/UIN
37AAHCS4056Q272M

State Jurisdiction

TIRUPATI-II (Jurisdicticnal Office)

Taxpayer Type

Regular

Field Visit Conducted?

No

Legal Name of Business

SOUTHERN POWER DISTRIBUTION
COMPANY OF AP LIMITED

Date of registration

01/07/2017

GSTIN / UIN Status

Active

The APEPDCL GST Information as follows:

Search Result based on GSTIN/UIN : 37AAACES876B1ZH

GSTIN/UIN
3I7AAAMCESBYEB1ZH

State Jurisdiction

DWARAKAMNAGAR (Jurisdictional Office)

Taxpavyer Type

Regular

Field Visit Conducted?

Mo

Legal Name of Business

EASTERN POWER DISTRIBUTION COMPANY
OF ANDHRA PRADESH LIMITED

Date of registration

01/07/2017

GSTIN / UIN Status
Active

& |9

Entity number of the same
PAN holder in a state

Alphabet ‘Z’' by default

Check sum digit

Centre Jurisdiction

CHITTOOR-1 RANGE

Constitution of Business

Public Limited Company

Date of Cancellation

Centre Jurisdiction

AKKAYYAPALEM

Constitution of Business

Public Limited Company

Date of Cancellation

The CCL Products SEZ Customer GST Information as follows:

Search Result based on GSTIN/UIN : 37AAACC9552G3ZI

GSTIN/UIN
37AAACCIOS52G3ZI

State Jurisdiction

PUTTUR (Jurisdictional Office)

Taxpayer Type

SEZ Unit

Field Vvisit Conducted?

No

After Receipt of KYC
mdmone@aptransco.gov.in,

form,

Legal Name of Business

C C L PRODUCTS (INDIA) LIMITED

Date of registration

06/09/2017

GSTIN / UIN Status

Active

the same

should be

Centre Jurisdiction

SRI KALAHASTHI RANGE

Constitution of Business

Public Limited Company

Date of Cancellation

sending to

sdone@aptransco.gov.in &

sdsapaptunes@gmail.com, along with purpose of creating Customer KYC
information. The purpose is as follows:
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Works:
Sales:
Services:

Lease:

a ok L b=

Miscellaneous:

1000-20-30 (Sales Area)
1000-20-40 (Sales Area)
1000-20-50 (Sales Area)
1000-20-60 (Sales Area)
1000-20-99 (Sales Area)

7. The Customer ID will be intimated by either MDM or SD core Team.
After receipt of Customer ID, before creating order, please verify the customer is
available in SAP using following Transaction codes.
1. VCUST Customer List
2. XD0O3 Display Customer (Centrally)
3. VDO3 Display Customer (Sales)
4. FDO3 Display Customer (Accounting)
9. Further go to Sales Area Data --> Billing Documents Tab --> Taxes --> Verify the
Customer Tax Classification. The details as follows:
Taxes
Country MName Tax categ  Mame Tax... | Description
I India JOCG IN: Central GST 0 GST Exempt
IN India JOIG IM: Integrated GST ] GST Exermpt
IN India JOSG IN: State GST 0 GST Exempt
Taxes
Country Mame Tax categ Mame Tax... |Description
IN India JOCG IN: Central GST 1 GST Liable
IN India JOIG IN: Integrated GST 1 GST Lizble
IN India JOSG IM: State G5T 1 GST Liable
Taxes
Country MName Tax categ |Mame Tax... Description
IN India JOCG IM: Central GST 2 SEZ Customers
IN India JOIG IM: Integrated GST 2 SEZ Customers
IN India JOSG IM: State GST 2 SEZ Customers
10. After Creation of Order, it is requested to verify the following.
Customer State | GSTIN State | Customer Tax Classification Applicable GST
01: AP 37 : AP SGST: 0, CGST: 0, IGST: O GST exemption
O1: AP 37 : AP SGST: 1, CGST: 1, IGST: 1 SGST & CGST
State # 01 State # 37 | SGST: 1, CGST: 1, IGST: 1 IGST
01: AP : SEZ 37:AP SGST: 2, CGST: 2, IGST: 2 IGST
11. Before sending the approval process, it is requested to verify the amounts, GST

Taxation amount and applicable GST. Any deviation, it is requested to contact
the SAP SD core team for clarification.




Scrap Sale Process Guidelines

After Approval of Survey Report, AE/Maintenance shall carry out the Scrap Generation
Process (i.e., Scrap Stock creation) in the corresponding Storage Location, as per the
Standard Process (Devolution Order “DVO01”) of Plant Maintenance (PM) Module. Each
Substation is designated as a Storage Location in SAP.

After Creation of Stock in Storage Location, the same may be intimated to Concerned
ADE, DE and SE/OMC or O&M.

Every Month SE/OMC or O&M shall furnish the Change return to Chief Engineer Zone, on
the availability of Surveyed Scrap Material, after verifying the stock in SAP, Using T-Code
MMBE or MB52. Further the screen Shot/Print Output may be furnished to Chief Engineer,
lone.

The Concerned AE/ADE in O/o Chief Engineer Zone, shall inform the same to M/s. MSTCL
authorities and to the Chief Engineer/ Transmission / VS , after reaching certain Quantity as
per the prevailing practice, duly verifying the stock in SAP Using T-Code MMBE or MB52.

S.No. Description of | HSN Code | Circle Storage Quantity %GST
Material Location Applicable

After Receipt of Conformation of Sale from M/s. MSTCL, the Chief Engineer Zone shall issue
instructions to the respective Circle Offices/APTRANSCO to create a Sale order along with
following information.

S.No. | Description HSN Circle Storage | Quantit | Price %GST Total
of Material Code Location |y Per Applicable | Amount
UoM

Scrap having two types.
1. By default Scrap — No Survey report is required.
2. Surveyed Scrap — Approved Survey Report shall be required.

Concerned Circle Office/APTRANSCO shall create a Sale Order in SAP on the Respective
Customer, as per the Instructions given by Chief Engineer / Zone and M/s. MSTCL
Authorities.

Pre-requisite conditions before Creating Sale Order in SAP:-

8.
9.

10.
1.

12.

AE/T, Circle Office shall collect the filled in Customer KYC Form from the customer.

The same is to be intimated to MDM Team and SD Team (mdmone@aptransco.co.in;
sdone@apiransco.co.in; sdsapaptunes@gmail.com) to enable the core team to create
Customer ID in SAP.

The Core Team will intimate the Customer ID after creation in SAP.
Customer Information is fo be checked-up.

Go to XD03 and - General Data - Address Tab > Verify the Address > Confrol Data
Tab > Verify GST No

Go to company Code data - Go to Account Management tab = Verify Recon
Account should be 28103 and Sort Key 702.

Go to Sales area Data - Biling Document Tab >
GST should be > SGST: 1, CGST: 1, IGST : 1

Material Information is to be checked up in SAP. The following Information is to be prepared
in Excel Sheet.
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S.No.

1.

2. Material Description

3. Material ID,

4, Go to T Code MMO03 and enter the Material ID and enter.
(Plant>XXXX, Sales Organisation—=> 1000, Distribution Channel->20)

5. Go to Sales: Sales Org.1 Tab: Verify the Tax Data -

GST should be - SGST: 1, CGST: 1, IGST : 1
6 Go to Sales : Sales Org.2 Tab : Verify the Grouping Terms.
7. Account Assignment Group : 07-> Sale of Material,
8. General ltem Category Group : NORM,
9 ltem Category Group : for Scrap Sales > ZSCP
1
1

0. Go to Foreign Trade Export Tab - Foreign Trade Data, Note the HSN Code.
1. Any Discrepancies are observed should Contact the SD Core team.

13.  Tax Master Information is to be checked up. T Code : VK13 or V/LD (JOSG, JOCG & JOIG,
JTICS)-> Verify the Tax Percentage is maintained.

14.  If any Discrepancies are observed in XD03, MM03, VK13 & V/LD should Contact the SD Core
team.

15. The following Information is to be prepared in Excel Sheet> Business Area Wise (Plant &
Store) and Storage Location Wise.

A. Material ID 2000 XXXX

B. Order Quantity Qty

C. Plant 1010 to 1070 (Stores) & Circle (2XXX, 3XXX, 5XXX)
D. Storage Location XXXX (Detailed Information is given below)

E. Scrap Survey Price (ZSCP) Approved Survey Price of individual Item in case of

Surveyed Material.
Intimation of Scrap Value to MSTCL in case of
Default Scrap by CE/Zone.

F. Basic Sale Price (ZBSP) MSTCL is giving Lump sum Sale Price. This is to be
apportioned to Material Wise based on survey
price. Total Amount (Sale Price) should be
Matched.

G. MSTCL Service Charges (Info) It Contains the Following items.

1. MSTCL Commission Charges (JMST)

2. GST on Commission (ZMST)

MSTCL is giving Lump sum Service Charges. This is
to be apportioned to Material Wise based on
survey price. Total Amount (Service Charge)
should be Matfched.

H. MSTCL Commission (JMST) JMST = MSTCL Service Chares/1.18

l.  GST on MSTC Commission (ZMST) 18 (ZMST = JMST X 18%)

16.  After Completion of Excel sheet — Contact the SD Team for Creation of Sale Order.
Creation of Sale Order in SAP

17. 1. TCode : VAO1

Type of Sale Order : ZSCP

Sales Organisation : 1000 ( APTRANSCO Sale Organisation)

Distribution Channel : 20 (Sale, Service, Lease)

Division : 40 (APT-Materials)

o0 O A LN

Sales Office: Plant or Accounting unit or Business Area, Other Than Stores.




18.

19.

20.

21.

22.

23.

24.

25.

In a Sale order, Quantity must be entered storage Location and Material wise. (Storage
Location Wise Material Sequence is Best Option for easy understanding the process and
future verification is easy).

A

Storage Location : X X X X

15t Letter Represents Zone \_ )
\" - Visakhapatnam Zone

B > Vijayawada Zone Sr Number

K - Kadapa Zone

2nd Letter Represents <
0.1 - 132 KV Substation
2 - 220 KV Substation

3 - Lines and Other Subdivisions (Except Maintanence Subdivisions)
4 - 400 KV Substations

5 - Division Offices

6 - Circle Offices

999 > Zonal office

Material ID for Non-Valuated Scrap :INVM : 2000 0OXXX (Preferably)
Material ID for Scrap Material : ISCR : 4050 OXXX
Against Each Material, it is requested to enter amounts for the following.
1. ZSCP Scrap Survey Price

2. IBSP Basic Sale Price

3. JMST MSTCL Commission

4. IMST GST on MSTCL Commission

The following Documents are to submitted to Concerned SE for approval, through work
flow. ADE - DE (Tech/Trans) > SAO/AQO preferably through FLM.

Sale Order Copy

Display Header Details = Condition Tab = Screen Shot

MSTCL Sale Order

MSTCL Delivery Order

Chief Engineer / Zone Instructions

SAO/AO has to verify the following Amounts in the furnished documents.

aorLDd -

Scrap Survey Price (ZSCP)
Base Sale Price (ZBSP)
Tax Collected at Source (JTCS)
MSTC Commission (JMST)
GST on MSTCL Commission (ZMST)
TDS is Accounting Posting. Not covered in Sales Module.
Document Management System (DMS): The following Copies are to be attached to sale
order for future reference.
1. MSTCL Sale Order
2. MSTCL Delivery Order
3. Chief Engineer/Zone Instruction for sale of Scrap
(Chief Engineer/Zone is requested to send the MSTCL Scrap Sale Instructions to
respective Superintending Engineers through FLM).
After Receipt of Amount from respective Customer, go to VA02, enter the Sale order no,
Billing Blocks in Header level and Item Level shall be removed and go to Sales Document->
Biling (VFO1) and Save. Invoice No will be generated. (90000 XXXXX).

AR ol S




26.

27.

28.

29.

30.

31.

32.

33.

Circle Office/APTRANSCO shall issue Release Order (Physical Copy) to concerned
Customer, with a Copy to respective DE/O&M, ADE/Maintenance and AE/Maintenance
(through FLM or SAP Business Place or email) for delivery of Material. (This is under
development in SAP)

When the representative of Customer is coming to Substation (Storage Location), the
respective AE/M shall issue/deliver the material and the same is to be carried by Using T
Codes VLO1N, VLO2N and VLO3N in SAP.

Outbound delivery is nothing but you send the material out from your premises abiding the
formalities.

Post Goods issue is done when physically the goods are moved from Stores or Substation
after Delivery is fully picked.

> Store/Substation stock of the material is reduced by the delivery quantity -

> Value changes are posted to the balance sheet account in inventory accounting -

> Goods issue posting is automatically recorded in the document flow.

VLO1TN: Create Out Bound Delivery : OBD: For the Purpose of creating Delivery.

VLO2N: Change Out Bound Delivery :PGI: For the Purpose of Post Goods Issue

VLO3N: Display Out Bound Delivery: For the Purpose of Printing Gate Pass/Delivery Note.
Please enter the Details of Representative Name, Vehicle No and remarks if any, in the
Gate Pass/Delivery Note and finally take the signature of the representative which
acknowledges the delivery of Goods to the customer.

Please verify the Material in MMBE or MB52, before Issuing the Material and after issuing the
Material.

The Gate Pass/Delivery Note copy may be furnished to concerned ADE/Maintenance,
DE/O&M and SE/OMC or O&M for information through FLM, SAP Business work Place or
email.

It is requested to review, whether the Material is delivered to customer on weekly basis by
concerned AE, ADE or DE/Tech of Circle office and Zone Office.

Concerned AE or ADE or DE/Tech of Circle office and Zone Office has to give the detailed
report MSTCL sale order wise, delivery status on regular intervals to Chief Engineer /
Transmission for review.

During the process, if any problems are faced, please contact the SD Core team for
resolving the issues.

sdone@aptransco.gov.in
sdlead@apiransco.gov.in
se.it.erp@apiransco.gov.in
sdsapaptunes@gmail.com

Ph No: 73822 96933 or 94403 36984

ARl S A e
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Removed/Used Transformer Oil Sale Process Guidelines

AE Maintenance shall check-up the quantity of Used/Removed Transformer Oil
along with Barrels/Drums in the Sub-station. Each Substation is designated as a
Storage Location (SLoc) in SAP.

AE Maintenance shall carryout the Removed/Used Transformer Oil and
Barrels/Drums  Generation Process (i.e., Scrap Stock Generation) in the
corresponding Storage Location, as per the Standard Process (Devolution Order
"DV01") of Plant Maintenance (PM) Module.

After Creation of Stock at Sub-station i.e. Storage Location, the same shall be
intimated to the concerned ADE, DE/O&M and SE/OMC or O&M.

Every Month SE/OMC or O&M shall furnish change return to Chief Engineer Zone on
the availability of Removed/Used Transformer Oil along with barrels/Drums after
verifying the stock in SAP, Using T-Code MMBE or MB52. Further the screen shot/ print
output may be furnished to Chief Engineer, Zone.

The Concerned AE / ADE in O/o Chief Engineer Zone shall inform the same to
respective DISCOM authorities after reaching certain quantity as per the prevailing
practice, duly verifying the stock in SAP, Using T-Code MMBE or MB52.

After receipt of confirmation from respective DISCOM, the Chief Engineer Zone shall
issue instructions to the respective Circle Offices/APTRANSCO to create a Sale order
along with following information.

S.No. | Description of | HSN Circle Storage Quantity | Price %GST Total Amount
Material Code Location Per UoM | Applicable

Concerned Circle Office/APTRANSCO shall create a Sale Order in SAP on respective SE/

Operation/ DISCOM (either APSPDCL or APEPDCL) as per the Instructions given by Chief
Engineer / Zone.

Pre-requisite Condition Before Creating of Sale Order

8.
9.

10.
1.

12.

iv.

Concerned AE in shall collect the filled in Customer KYC Form from the customer.

The same shall be intimated to MDM Team and SD Team
(Mdmone@aptransco.co.in; sdone@aptransco.co.in; ) to Update the customer
Information in SAP.

The core team will intimate the Customer ID after creation in SAP.

Customer Information is to be Checked up, as mentioned below.
Go to XD03 and - General Data - Address Tab > Verify the Address > Control
Data Tab = Verify GST No

Go to company Code data - Go to Account Management tab - Verify
Recon Account should be 28103 and Sort Key Z02.

Go to Sales area Data = Biling Document Tab = GST should be

SGST: 1, CGST 1, IGST :1.

If any Discrepancies are observed, the SD Core team shall be contacted.
SD Module: Core team will check the HSN Codes of Materials and Maintain the Tax
Master against the HSN Code and Check the TCS Condition and Maintain the TCS
0% or Not applicable for Removed/Used Transformer Qil Sale process to DISCOMs.
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13.

14.

15.

16.

Material Information shall be checked up in SAP. The following Information shall be
prepared in Excel Sheet.

1. S.No

2. Material Description

3. Material ID,

4. Go to T Code MMO03 and enter the Material ID and enter.

(Plant>XXXX, Sales Organisation-> 1000, Distribution Channel>20)

5. Go to Sales: Sales Org.1 Tab : Verify the Tax Data >

GST should be » SGST: 1, CGST :1, IGST :1.

6. Go to Sales: Sales Org.2 Tab : Verify the Grouping Term:s.

7. Account Assignment Group : 07> Sale of Material,

8. General ltem Category Group : NORM,

9. Go to Foreign Trade Export Tab - Foreign Trade Data, Note the HSN Code.
MMO02-> Material Type INVM INVM LSCR
MMO02->Item Category Group NORM LSCP LSCP
Allowable Sale Order Type LMAT LSCP ISCP

Tax Master Information is to be checked up. T Code: VK13 or V/LD (JOSG, JOCG,
and JOIG)-> Verify the Tax Percentage is maintained. Similarly for TCS.

The following Information shall be prepared in Excel Sheet Business Area Wise (Plant

& Store) and Storage Location Wise.

1. Material ID, 2. Order Quantity, 3. Plant, 4. Storage Location, 5. Basic Sale Price.
After Completion of Excel sheet — Contact the SD Team for Creation of Sale Order.

Creation of Sale Order

17.

18.

S.No Description Sales Area
1 Transaction Code VAO1 VAO1
2 Type Of Sale Order IMAT ISCP
3 Sales Organisation 1000 1000
4 Distribution Channel 20 20
5 Division 40 40
6 Sales Office=Plant= A/C Unit XXXX XXXX

The Customer Ids of Superintending Engineer/Operation createdin SAP is as
follows :

1. SE/Operation/Tirupati - 10000 00268
2. SE/Operation/Anantapur - 10000 00269
3. SE/Operation/Kadapa - 10000 00270
4. SE/Operation/Kurnool - 10000 00271
5. SE/Operation/Nellore -10000 00272
6. SE/Operation/Ongole - 10000 00273
7. SE/Operation/Guntur - 10000 00640
8. SE/Operation/Vijayawada - 10000 00274
9. SE/Operation/Rajamahendravaram - 10000 00275
10. SE/Operation/Eluru - 10000 00274
11. SE/Operation/Visakhapatnam - 10000 00277
12. SE/Operation/Vizianagaram - 10000 00278
13. SE/Operation/Srikakulam - 10000 00279
14. KRESCO LIMITED - 10000 00174

Order Reason : Sale of used Transformer Ol




19.
20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

In a Sale order, Quantity must be entered Material wise and storage Location wise.
Material ID for Removed/Used Transformer Oil : 20000037(ZNVM)/ 40500112(ZSCR)
Material ID for Empty Oil Drums : 20000040(ZNVM)/ 40500051(ZSCR)
Material ID for Removed Transformer Oil with Barrel  : 20000038(ZNVM)/ 40500113(ZSCR)

The Sale Order Copy Print output is to be taken and after approval from the
concerned SE, through concerned ADE, DE(Tech) & SAO/AQO. SAO/AQO has to verify
the Amounts of Sale Order.

The Chief Engineer Zone copy can be attached to Sale order as a DMS Process for
future reference.

After Receipt of Amount from respective SE/Operation, go to VA02, enter the Sale
order no, Billing Blocks in Header level and Item Level shall be removed and go to
Sales Document-> Billing (VFO1) and Save. Invoice No will be generated. (90000
XXXXX).

Circle Office/APTRANSCO has to issue Release Order (Physical Copy-SAP Format
Under development) to Concerned SE/Operation with a Copy to respective
DE/O&M, Concerned ADE & AE for delivery of Material. (Development in SAP
Under progress)

When the representative of SE/Operation is coming to Substation (Storage
Location), the respective AE has to issue/deliver the material and the same is to be
carried by Using T Codes VLOTN, VLO2N, VLO3N in SAP.

Outbound delivery is nothing but you send the material out from your premises abiding the
formalities.

Post Goods issue is done when physically the goods are moved from Stores or Substation
after Delivery is fully picked.

A. Store/Substation stock of the material is reduced by the delivery quantity -

B. Value changes are posted to the balance sheet account in inventory accounting -

C. Goods issue posting is automatically recorded in the document flow.

VLO1N : Create Out Bound Delivery : OBD : For the Purpose of creating Delivery.

VLO2N : Change Out Bound Delivery : PGl  : For the Purpose of Post Goods Issue

VLO3N : Display Out Bound Delivery : For the Purpose of Printing Gate Pass/ Delivery Note.

Please enter the details of Representative Name, Vehicle No and remarks if any, in
the Gate Pass/Delivery Note and finally take the signature of the representative
which acknowledges the delivery of Goods to him.

Please verify the Material in MMBE, before Issuing the Material and after issuing the
Material.

The Gate Pass/Delivery Note may be furnished to concerned ADE/Maintenance,
DE/O&M and SE/OMC or O&M for information.

It is requested to review the Material is get delivered to customer on daily basis by
concerned AE / ADE or DE/Tech of Circle office and Zone Office.

For any querries, please contact the SAP SD Core team.

sdone@aptransco.gov.in

sdlead@aptransco.gov.in

se.it.erp@apiransco.gov.in

sdsapaptunes@gmail.com

Ph No: 73822 96933 or 9440336984

Sl i
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FEED BACK FORM : APTUNES : SD MODULE : SALE, SERVICE, LEASE 7z

Name: EMP ID:
Designation: Office:
Phone Number: E-Mail Id:

1) How is the Customer Works Order (VAO1: ZGNW: 1000-20-30 ) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

2) How is the Sale Of Material Order (VAO1: ZMAT: 1000-20-40) Process

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

3) How is the Sale Of Transformer Oil & Scrap Order (VAOT1: ZSCP: 1000-20-40) Process

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

4) How is the Delivery Material Return Order (VAO1: ZRET: 1000-20-40) Process

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

5) How is the Services Order (VAOT1: ZSER: 1000-20-50) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

6) How is the Equipment / Material Lease Order (VAO1: ZLES: 1000-20-60) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

7) How is the Delivery Material Return Order (VAO1: ZRET: 1000-20-60) Process

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

8) How is the Non Stock Item, Land & Building Lease Order (VAO1: ZLES: 1000-20-60) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

9) How is the Miscellaneous Order (VAO1 :ZMIS: 1000-20-60) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

10) How is the Credit Memo/Note & Debit Memo (VAO1:ZCRN & ZDRN: Credit/Debit Note) Process

a) Excellent a) Good b) Satisfactory ¢) NeedsImprovement  d) Any Other

11) How is the Billing or Invoice (VFO1/VFO03 : Invoice/Billing) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

12) How is the Out Bound Delivery (OBD:VLO1N) & Post Goods Issue (PGI:VLO2N) Process

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

13) How is the Goods Delivery Return (IBR: VLOTN) & Post Goods Receipt (PGR:VLO2N) Process

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

14) The Information available in Display Document Flow process (DDF) & Their Understanding.

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

15) How is the Documents Attachment Process (DMS) in Sales order & View

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

16) How is the Work Flow Process through FLM (File Life Cycle Management)

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

17) How is the SAP Business Work Place (E-Mail) sending the Documents to Higher Authorities

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other




18) How is the Employees Self Service Report Business Intelligent (Bl) Report and Query the information

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

19) How is the Reporting T Codes (VAO5N) & Their processing & Querying

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

20) How is the Reporting T Codes (VFO5N) & Their processing & Querying

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

21) How is the Sales & Distribution (Revenue) Module Material/Manuals

a) Excellent b) Good «c) Satisfactory d) NeedsImprovement e) Any Other

22) Over All Feedback on Sales & Distribution (Revenue) Module

a) Excellent b) Good «c¢) Satisfactory d) NeedsImprovement e) Any Other

23) How Many Orders / Credit & Debit Notes / OBD & PGl / IBR & PGR / Invoices done

a) ZGNW(30) b) ZIMAT (40) c) ZSCP (40)
d) ZRET (40) e) ZSER (50) f)  ZLES (60)
g) ZRET (60) h) ZMIS (99) i) ZCRN
i) ZDRN k) OBD-601 ) PGI-601
m) IBR-602 n) PGR-602 o) INVOICES
24) Please furnish the following information in this sheet and handed over and sent mail to

1. se.t.ero@aptransco.co.in 2. sdlead@aptransco.co.in 3. sdone@aptransco.co.in

1.Comments  2.Remarks  3.Suggestions 4. Improvement 5. Any Other Processes are not covered

Date: Signature
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POWER & END USER TRAINING : USER IDS & PASSWORDS : 600 CLIENT

Sr. NO | NAME OF THE WING at field | PAYUNIT | TRAINING IDS | Password
Telecom Wing
1 Supt Engr /Telecom/Vijayawada 2601 ZSDSSLTRNG1 welcome1
2 Supt Engr /Telecom/Kadapa 2602 ZSDSSLTRNG2 welcomel
3 Supt Engr /Telecom/Visakhapatnam 2605 ZSDSSLTRNG3 welcome1
CE/Zone, SE/OMC, SE/O&M, SE/Construction
4 Chief Engincer/Zone, Visakhapatnam 5103 ZSDSSLTRNG4 welcome 1
5 ¢ Enginect/2one/ Visakhap 5103 ZSDSSLTRNG5 welcomel1
6 , 5114 ZSDSSLTRNG6 welcome 1
7 Supt Engr /OMC/Srikakulam 5114 ZSDSSLTRNG7 welcomel
8 5115 ZSDSSLTRNGS8 welcomel
E MC/Vizi
9 Supt Engr /OMC/Vizianagaram 5115 ZSDSSLTRNG9 welcomel
10 , 5103 ZSDSSLTRNG10 welcome 1
17| Supt Engr /OMC/Visakhapatnam 5103 ZSDSSLTRNG11 | welcomel
12 . 5109 ZSDSSLTRNG12 welcomel
13| Supt Engr /OMC/Rajahmundry 5109 ZSDSSLTRNG13 | welcomel
14 5116 ZSDSSLTRNG 14 welcome1
E MC/El
15 | Supt Engr /OMC/Eluru 5116 ZSDSSLTRNG15 | welcomel
16 Chief Engineer,/Zone/ Vij d 5105 ZSDSSLTRNG16 welcome1
17 ¢ Enginect/2one/ Vyayawaca 5105 ZSDSSLTRNG17 | welcomel
18 .. 5105 ZSDSSLTRNG18 welcomel
19 | Supt Engr /OMC/Vijayawada 5105 ZSDSSLTRNG19 | welcomel
20 5117 ZSDSSLTRNG20 welcomel
E M
o1 | Supt Engr /OMC/Guntur 5117 ZSDSSLTRNG21 | welcomel
22 5118 ZSDSSLTRNG22 welcomel
o3 | Supt Engr /OMC/Ongole 5118 ZSDSSLTRNG23 | welcomel
24 5107 ZSDSSLTRNG24 welcomel
g5 | Supt Engr /OMC/Nellore 5107 ZSDSSLTRNG25 | welcomel
26 5104 ZSDSSLTRNG26 welcomel
hief Engi Z K
o7 | Chief Engineer/Zone/ Kadapa 5104 ZSDSSLTRNG27 | welcomel
28 5104 ZSDSSLTRNG28 welcomel
g9 | Supt Engr /O&M/Kadapa 5104 ZSDSSLTRNG29 | welcomel
30 5104 ZSDSSLTRNG30 welcomel
31 | Supt Engr /Const/Kadapa 5104 ZSDSSLTRNG31 | welcomel
32 5110 ZSDSSLTRNG32 welcomel
E M/K 1
33 | Supt Engr /O&M/Kurnoo 5110 ZSDSSLTRNG33 | welcomel
34 Supt Engr /Const/Kurnool 5110 ZSDSSLTRNG34 welcome1
35 Upt Engr /-onst/ Burnoo 5110 ZSDSSLTRNG35 | welcomel
36 5119 ZSDSSLTRNG36 welcomel
37 | Supt Engr /OMC/Anathapur 5119 ZSDSSLTRNG37 | welcomel
38 3203 ZSDSSLTRNG38 welcomel
E MC/Ti hi
39 | Supt Engr /OMC/Tirupathi 3203 ZSDSSLTRNG39 | welcomel
SE/400KV/OMC, SE/400KV/O&M, SE/400KV/Construction
40 3100 ZSDSSLTRNG40 1 1
Supt Engr /400KV/O&M /Kapalaka wecome
41 3100 ZSDSSLTRNG41 welcome1
42 Supt Engr/400KV/Const/ 3100 ZSDSSLTRNG42 welcome1
43 Visakhapatanm 3100 ZSDSSLTRNG43 welcomel
44 .. 3312 ZSDSSLTRNG44 welcome1
25 | Supt Engr /400KV/OMC/Vijayawada 3312 ZSDSSLTRNG45 | welcomel
46 3315 ZSDSSLTRNG46 welcomel
47 | Supt Engr /400KV/OMC/Kadapa 3315 ZSDSSLTRNG47 | welcomel
48 Emergency Spare IDs ZSDSSLTRNG48, 49 & 50 welcome1
49 Delivery IDs ZPMDELTRNG 1 to 20 welcomel




